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ABOUT THE X2 SYSTEM
The RaySafe X2 consists of a base unit, sensors and the X2 View computer software.

The sensors options are:

R/F, for radiography and fluoroscopy measurements, with or without a phantom between the sensor
 and the
X-ray source.
MAM, for all kinds of mammography measurements.
CT, an ionization chamber for measurements on CT dose applications.
Light, for illuminance measurements and luminance measurements on monitors and light boxes.
mAs, an integrated tube current meter.

X2 View is a PC software for use with the X2 instruments. In X2 View, you can view measurements and
 waveforms on a larger display, store measurements, transfer data to Excel or other software and get
 software updates for the base unit.

When you want to measure, all you need to do is:

1. Turn on the base unit
2. Connect a sensor
3. Position the sensor
4. Expose

For more detailed information, see the help chapter for each sensor.
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NAVIGATE THE BASE UNIT
The base unit has a touch screen and three buttons.

Swipe up and down on the home screen to access your previously recorded measurements.
Swipe right
 from the home screen to go to the setup screen, from which you can make settings and view
information
 about the system, for example the calibration date for a connected sensor.
Tap on a parameter to get
 larger digits, one parameter at a time. You can also measure in this mode.
From the single parameter
 screen, you can swipe right to view the measurement specifications, and left to see waveforms, if available.

The three buttons below the screen are:

Menu, brings up a menu on the screen
Home, takes you to the home screen
Back, takes you back to the previous screen

On the back side of the base unit are:

Reset switch, for forced reboot of the base unit
Charger/PC connector, for charging or using with a PC with X2 View
mAs connector, for tube current measurements
Two sensor connectors
Ethernet connector, for future use
On/Off switch. Press the button shortly to enter sleep mode. After a while in sleep mode,
the base unit
 will turn off automatically. Press the button for 2 seconds to turn off the base unit immediately.
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CHANGE PARAMETER VIEW
To change the number of parameters showed on the home screen, press the menu button
and select
 Change view. There are two views to toggle between:

All measured parameters, or
Four key parameters of your own choice. Press and hold on a box to select which parameter to show.
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ANALYZE WAVEFORMS
View a single parameter by tapping on that parameter on the home screen. Swipe left to go to the
 waveform screen.

The dark line represents an average of the measured values. If
 there are more values than possible to show on the screen,
 the light blue pixles represent the range of these values.

The dashed lines indicate the measured parameter values, in
 this case average dose rate and time.

Tap on the button in the upper right corner to analyze the waveform.

Slide the handles to view, for example, the peak dose rate of a
 pulse.

Tap the button again to exit the analyze mode.
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CONNECT THE BASE UNIT TO A COMPUTER
Connect the base unit to a computer running X2 View using
 a USB cable. X2 View can be installed from the X2 View CD,
 that came with the system.

If you measure, the results will automatically show up in X2
 View.

You can also select Import from Base Unit in the File menu

to import measurements stored in the base unit.

From X2 View, you can export measurements to Excel and
 other software.
For more information, see the X2 View help,
 reached from the Help menu in X2 View.
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CONNECT TO COMPUTER USING BLUETOOTH
Connect the Bluetooth adapter to a SENSOR port on the
 base unit. A gray Bluetooth status symbol appears in the
 upper
right corner of the screen.

X2 View will automatically search for base units. The first time you connect, you will have to select your
base
 unit from the Bluetooth menu in X2 View. The Bluetooth status symbol will turn white when connected.

When restarting X2 View, the base unit will automatically get connected.
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ACCESS STORED MEASUREMENTS
Measurements from previous sessions are automatically stored in the base unit. The memory allows about
 10000 measurements. When the memory is full, the oldest measurements are automatically deleted.

To access stored measurements, connect the base unit to a computer running X2 View and select Import
 from base unit under the File menu.

The measurements are sorted by date and time.
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UPGRADE THE BASE UNIT SOFTWARE
Connect the base unit to a computer running X2 View and
 make sure that the computer is connected to internet. If
 there are any updates available, the X2 Online field will
 show a notification symbol. Click on that symbol and follow
 the instructions to upgrade the software.
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CHARGE THE BATTERY
To charge the base unit, connect it to a wall socket with the included power supply. The charging time is
 approximately 4 hours.

The battery lasts for about one day of extensive usage, which means that it is recommendable to start your
 working day with a fully charged unit.

The X2 system automatically enters power saving mode when idle for some minutes. If the system does not
 wake up by radiation or the buttons on the front, press the power button.

Tip! The base unit will maintain the energy level when connected to a computer.
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USE THE FLEXI STAND
The flexi stand can be used in many different setups. Below are some examples.
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SETTING: SCREEN BRIGHTNESS
Adjust the screen brightness by sliding the bar.

Reduce the brightness to prolong the base unit battery time.
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SETTING: TIME AND DATE
Set time and date according to your local time. Measurements are automatically stored in the base unit,
 sorted by time. You can view them afterwards using X2 View.
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FINAL DISPOSAL OF THE SYSTEM
Final disposal is when the user disposes of the product in such a way that it can no longer be used for its

intended purpose(s).

In the European Union (the WEEE directive), this label indicates that this product should not be disposed of
 with
household waste.

This product should be disposed of at an appropriate facility to enable recovery and recycling.

Unfors RaySafe supports users in:

Recovering reusable parts.
Recycling of useful materials by competent disposal companies.
Safe and effective disposal of product.

For advice and information, contact your Unfors RaySafe Service Organization first, or otherwise the
 manufacturer.
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REGULATORY INFORMATION

N28111

Unfors RaySafe K.K.
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MEASURE WITH R/F SENSOR
Place the connected sensor centered in the field with the
 crosshair towards the X-ray source. The angle of the sensor
 in the horizontal plane has no impact on the measurement
 result.

Expose.

Read the result.

Tip! Tap a parameter to get large digits, parameter information, and, if applicable, waveform. Switch
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 between these by swiping sideways.

Note! The dark line centered in the circle represents the active area of the sensor. The lines on the side
 of the housing marks the vertical position.
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R/F SENSOR: MEASUREMENT PARAMETER
 DEFINITIONS
Dose and HVL are calculated from all recorded data.

Dose rate is the average dose rate, calculated as dose/time.

Time starts the first time the dose rate waveform reaches 50% of peak, and ends the last time it drops
 below 50%. Intermediate values are time since start trig.

kVp and total filtration are calculated from an average of samples above ~90 % of peak signal level.

Pulses are counted at every start trig with more than 4 ms since last end trig.

Pulse rate and dose per pulse are averages from the last 6 pulses.

For measurements longer than 3 s, the final readings of dose rate, kVp, HVL and total
 filtration are moving averages ending approximately 1–2 s before end trig. Intermediate readings are
 moving averages.

Note! If measurements are made simultaneously with the R/F sensor and mAs cable, any shared
 parameter (time, pulses or pulse rate) will be taken from the R/F sensor.
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SETTING: DOSE UNIT
Select if all dose units should be displayed in Gray or Röntgen.

1 Gy = 114.1 R

X2 systems approved by PTB does not have the possibility
to change the dose unit to Röntgen (R).
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SETTING: IGNORE PREPULSES
Use the ignore prepulses setting to remove one or many unwanted prepulses from the measurement.

Ignore prepulses = 0, the whole exposure is captured.

Ignore prepulses = 1, the (first) prepulse is excluded from the measurement.

Note! This setting will affect all parameters, including the dose measurement.
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SETTING: STOP DELAY
The stop delay setting defines for how long the instrument will wait for more radiation to include in the same
 measurement.

Use a longer stop delay when measuring on a pulsed fluoroscopy system or to get a prepulse recorded into
 the same measurement as the following ordinary exposure.

Stop delay setting longer than the time between pulses (t>T), will result in one long measurement. Note that
 you have to wait as long as the stop delay setting (t) after the last exposure before the measurement ends
 and values will be displayed.

Stop delay setting shorter than the time between pulses (t<T), will result in many short measurements (one
 for each pulse).
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MEASURE WITH MAM SENSOR
The MAM sensor is ready to measure dose and HVL for all
 anode/filter combinations without changing any settings.
	Place the connected sensor centered in the field, with the
 crosshair 6 cm (4 cm in the US) from the examination table
 front edge (A). The angle in the horizontal plane has
 neglectable impact on the measurement result.

For kVp measurements, select your anode/filter combination
 in the sensor settings, or by swiping right from the home
 screen to access the quick settings.

Note! When measuring kV on Mo/Rh, use the included 2 mm Al filter. Follow the instructions printed on
 the filter.

Expose.

Read the result.
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Tip! Tap a parameter to get large digits, parameter information, and, if applicable, waveform. Switch
 between these by swiping sideways.

Note! The dark line centered in the circle represents the active area of the sensor. The lines on the side
 of the housing marks the vertical position.
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MO/RH KV WITH MAM SENSOR
Place the sensor centered and 6 cm from the chest wall.
	Place the 2 mm Al filter on the sensor. Be sure to cover the
 active sensor area.

Recommended generator setting ≥ 100 mAs.

Select Mo/Rh 2 mm Al in the sensor settings.
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W/AL SCANNING WITH MAM SENSOR
Mount the X2 MAM sensor in the holder.

Place the holder centered on the table, tight to the chest
 wall.

Settings:

X2: Generic (W/Al if kVp is desired), Stop delay: 2 s

Philips MicroDose: 8 mAs

Fischer SenoScan: 70 mA

Adani: fastest scan speed

Always use the compression paddle, positioned as high as possible. Do not use the AEC functionality.
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MAM SENSOR: MEASUREMENT PARAMETER
 DEFINITIONS
Dose and HVL are calculated from all recorded data.

Dose rate is the average dose rate, calculated as dose/time.

Time starts the first time the dose rate waveform reaches 50% of peak, and ends the last time it drops
 below 50%. Intermediate values are time since start trig.

kVp is calculated from an average of samples above ~33 % of peak signal level.

Pulses are counted at every start trig with more than 4 ms since last end trig.

Pulse rate and dose per pulse are averages from the last 6 pulses.

Intermediate readings of dose rate, kVp and HVL are moving averages. Final readings are based on the
 whole measurement.

Note! If measurements are made simultaneously with the MAM sensor and mAs cable, any shared
 parameter (time, pulses or pulse rate) will be taken from the MAM sensor.
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SETTING: BEAM QUALITY
The MAM sensor is ready to measure dose and HVL for all beam qualities without any settings. However, to
 get a kVp reading you have to select a beam quality.

If your beam quality is not in the list, you have to change your anode/filter combination to one of the listed.

Expose, and you will get a kVp reading which is applicable to all anode/filter combinations for the
 mammography machine (since the high voltage generator will behave identically regardless of selected
 anode/filter combination).

Note! This setting will only affect the kVp measurement.
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SETTING: DOSE UNIT
Select if all dose units should be displayed in Gray or Röntgen.

1 Gy = 114.1 R

X2 systems approved by PTB does not have the possibility
to change the dose unit to Röntgen (R).
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SETTING: STOP DELAY
The stop delay setting defines for how long the instrument will wait for more radiation to include in the same
 measurement.

Use a longer stop delay when measuring on a pulsed fluoroscopy system or to get a prepulse recorded into
 the same measurement as the following ordinary exposure.

Stop delay setting longer than the time between pulses (t>T), will result in one long measurement. Note that
 you have to wait as long as the stop delay setting (t) after the last exposure before the measurement ends
 and values will be displayed.

Stop delay setting shorter than the time between pulses (t<T), will result in many short measurements (one
 for each pulse).
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SETTING: IGNORE PREPULSES
Use the ignore prepulses setting to remove one or many unwanted prepulses from the measurement.

Ignore prepulses = 0, the whole exposure is captured.

Ignore prepulses = 1, the (first) prepulse is excluded from the measurement.

Note! This setting will affect all parameters, including the dose measurement.
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MEASURE WITH CT SENSOR
Push the connected sensor tight into the phantom ...

... or use the flexi stand for positioning free in air.

Expose.

Read the result.
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Note! The effective length of the CT sensor is 100 mm, and is marked with center and edge lines on the
 tube.

Tip! Tap a parameter to get large digits, parameter information, and, if applicable, waveform. Switch
 between these by swiping sideways.
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MEASURE KVP ON CT
For kVp measurements, use an R/F sensor. Position it flat on
 the table and expose without rotation, using scout,
 tomogram or topogram mode. Use no or slowest table
 movement.
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CT SENSOR: MEASUREMENT PARAMETER
 DEFINITIONS
Dose is calculated from all recorded data.

Dose rate is the average dose rate, calculated as dose/time. For measurements longer than 3 s,
	intermediate readings are moving averages.

Time starts the first time the dose rate waveform reaches 50% of peak, and ends the last time it drops
 below 50%. Intermediate readings are time since start trig.

Dose length product is dose·10 cm.
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SETTING: DOSE UNIT
Select if all dose units should be displayed in Gray or Röntgen.

1 Gy = 114.1 R

X2 systems approved by PTB do not have the possibility
to change the dose unit to Röntgen (R).
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SETTING: STOP DELAY
The stop delay setting defines for how long the instrument will wait for more radiation to include in the same
 measurement.

Use a longer stop delay when using a phantom and a slow rotation rate, to prevent that an axial scan will be
 cut into two measurements.

Stop delay (t) setting longer than the time between pulses (t>T), will result in one long measurement. Note
 that you have to wait as long as the stop delay setting (t) after the last exposure before the measurement
 ends and values will be displayed.

Stop delay setting (t) shorter than the time between pulses (t<T), will result in many short measurements
 (one for each pulse).
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MEASURE WITH LIGHT SENSOR
Luminance: Place the connected sensor with the aperture
 centered on the area you want to measure, and with
 luminance selected on the sensor wheel.

Illuminance: Place the connected sensor with the diffuser
 in the direction you want to measure, and with illuminance
 selected on the sensor wheel.

The sensor is constantly measuring. If you want to store a
 value, press the button once the reading is stable.
The
 measurement will continue below the stored value.
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Tip! Tap a parameter to get large digits and parameter information. Switch between these by swiping
 sideways.

Zero adjust: If prompted to make a zero adjust, select
 zero adjust (0) on the sensor wheel. The zero adjust will
 take approximately 10 s.

Note! Store the sensor with the sensor wheel in a closed position (0 or illuminance),
to prevent dust in
 the optics.
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LIGHT SENSOR: MEASUREMENT PARAMETER
 DEFINITIONS
Illuminance is the amount of light incident on a surface.

Luminance is the amount of light emitted from a surface.
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SETTING: UNITS
Select between

cd/m² and lux, or
fL and fc

1 cd/m² = 0.2919 fL (luminance)

1 lux = 0.09290 fc (illuminance)
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MEASURE MAS
Switch off the X-ray generator.

Remove the jumper.

Connect the mAs cable to the base unit and to the
 generator.

Switch on the X-ray generator.
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Make an exposure and read the result.

Note! Users of RaySafe X2 mAs must be aware of the potential damage to generators and of electrical
 human hazards in case of improper connection or damaged equipment. RaySafe X2 mAs is intended for
 use only by personnel authorized in performing calibration and repair of X-ray equipment.

Tip! You can measure with the R/F or MAM Sensor and the mAs cable both connected to get radiation
 and generator current values at the same time.

Tip! Tap a parameter for large digits, to get information about that specific parameter, and, if applicable,
 see a waveform.
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MAS: MEASUREMENT PARAMETER DEFINITIONS
mAs is calculated from all recorded data.

mA is calculated as an average of all samples above 50% of peak. Rush currents are automatically
 removed. Intermediate readings are based on samples since last reading. For long measurements, the final
 reading is recorded approximately 1–2 s before end trig.

Time starts the first time the current reaches 50% of the calculated mA and ends the last time it drops
 below 50%. Intermediate readings are time since start trig.

Pulses are counted every time the signal reaches trig.

Pulse rate and mAs per pulse are averages for the last 6 pulses.

Note! If measurements are made simultaneously with a sensor and mAs cable, any shared parameter
 (time, pulses or pulse rate) will be taken from the sensor.
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SETTING: IGNORE PREPULSES
Use the ignore prepulses setting to remove one or many unwanted prepulses from the measurement.

Ignore prepulses = 0, the whole exposure is captured.

Ignore prepulses = 1, the (first) prepulse is excluded from the measurement.

Note! This setting will affect all parameters, including the dose measurement.
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SETTING: STOP DELAY
The stop delay setting defines for how long the instrument will wait for more radiation to include in the same
 measurement.

Use a longer stop delay when measuring on a pulsed fluoroscopy system or to get a prepulse recorded into
 the same measurement as the following ordinary exposure.

Stop delay setting longer than the time between pulses (t>T), will result in one long measurement. Note that
 you have to wait as long as the stop delay setting (t) after the last exposure before the measurement ends
 and values will be displayed.

Stop delay setting shorter than the time between pulses (t<T), will result in many short measurements (one
 for each pulse).
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APPLICATION NOTE: BARIUM GLASS
kV correction for some GE systems made in China 2010/2011 with K9 Barium glass
 mirror in the collimator
This application note is not yet available. Please contact technicalsupport@raysafe.com for more
 information.
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APPLICATION NOTE: SIEMENS SOMATOM
CT kV measurements on Siemens SOMATOM CT Scanners
This application note is not yet available. Please contact technicalsupport@raysafe.com for more
 information.

RaySafe X2 User Manual

51


	Local Disk
	RaySafe X2 help
	About the X2 system
	Navigate the base unit
	Change parameter view
	Analyze waveforms
	Connect the base unit to a computer
	Connect to computer using Bluetooth
	Access stored measurements
	Upgrade the base unit software
	Charge the battery
	Use the flexi stand
	Setting: Screen brightness
	Setting: Time and date
	Final disposal of the system
	Regulatory information
	Measure with R/F Sensor
	R/F Sensor: Measurement parameter definitions
	Setting: Dose unit
	Setting: Ignore prepulses
	Setting: Stop delay
	Measure with MAM Sensor
	Mo/Rh kV with MAM Sensor
	W/Al scanning with MAM Sensor
	MAM Sensor: Measurement parameter definitions
	Setting: Beam quality
	Setting: Dose unit
	Setting: Stop delay
	Setting: Ignore prepulses
	Measure with CT Sensor
	Measure kVp on CT
	CT Sensor: Measurement parameter definitions
	Setting: Dose unit
	Setting: Stop delay
	Measure with light sensor
	Light Sensor: Measurement parameter definitions
	Setting: Units
	Measure mAs
	mAs Sensor: Measurement parameter definitions
	Setting: Ignore prepulses
	Setting: Stop delay
	Application note: Barium glass
	Application note: Siemens SOMATOM




